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Water scarcity in the Serbian Danube: Agricultural land use and irrigation
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less summer precipitation, +2° C 

more consecutive dry days, +2° C 

More frequent droughts

Crop choice and rotation changes?

Fedja Grulovic/Reuters

Grant #80NSSC22K0467

Water scarcity

Credit: Irrigation Strategy Serbia

Irrigation expansion
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Economic models + 

decisions

● Crop choice

● Irrigation investment

● Historical + future

Hydrological/crop 

modeling

● Water balance

● Crop yield

● Historical and future

Remote Sensing

● Crop mapping

● Irrigated agriculture

● Evapotranspiration

Water scarcity in the Serbian Danube: Agricultural land use and irrigation

Grant #80NSSC22K0467



Lecture Objectives/Outcomes

1. Describe the relationship between LCLUC and the hydrological cycle

2. Understand the role of remote sensing data in hydrological model 
development and assessment

3. Describe hydrological modeling concepts and build a hydrological 
model

4. Build communication/understanding of hydrology and hydrological 
modeling concepts – modelers are the users of the data you 
produce!
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The classic 
water cycle 
diagram…

What is 
missing?

6



Introduction

• Global Hydrological Cycle
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Introduction

• Global Hydrological Cycle

Direct anthropogenic impacts related to land use

8



Land use 
extent

Distance to 
use

Land cover 
and 

land use 
(2019)

Hansen et al. (2022) Environmental Research Letters9

https://doi.org/10.1088/1748-9326/ac46ec


The relationship 
between agriculture 
and water resources

“Human intervention affects water 
resources directly through water use 
such as for irrigation, which 
accounts for 70% of global water 
withdrawal and 90% of water 
consumption (Siebert et al. 2010). Many 
hotspots of water scarcity globally 
correspond to intensively irrigated 
areas…”

Scanlon et al. (2023) Nature Reviews Earth and Environment 10

https://doi.org/10.5194/hess-14-1863-2010
https://doi.org/10.1038/s43017-022-00378-6
https://doi.org/10.1038/s43017-022-00378-6


The extent of human impact on rivers

Grill et al. (2019) Nature

Connectivity status index 

“Large contiguous river 
networks with intact 
natural connectivity 
(CSI = 100%) remain only in 
remote regions of the 
Arctic, in the Amazon Basin 
and, to a lesser degree, in 
the Congo Basin.” 11

https://www.nature.com/articles/s41586-019-1111-9


Change and impacts on 
the hydrological cycle

• Global warming

• Deforestation

• Urbanization

• Agriculture

• Grazing

• Wildland fire

• Reservoir construction

• Invasive species

• Mining/extractive industry

• Surface runoff

• Soil moisture

• Groundwater

• Evapotranspiration

• Streamflow

• Lakes + wetlands

Drivers of change

Fluxes and pools

Water Quality
• Sediment

• Nutrients

• Pesticides

• Heavy metals

• Fecal coliform bacteria
12



To understand change, we need to know the 
natural (reference) condition

13

REFERENCE IMPACT



How to quantify effect of change? Study design

• Before-after change
• Observed or future projection

• Control-impact 
• paired catchments

• Before-after control-impact

14

Xiao et al. 2022 Sci Tot Env

https://doi.org/10.1016/j.scitotenv.2021.151877


Connecting LCLUC to hydrology and water quality
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Time series discharge and water quality
in-situ measurements Observe/model change



Urbanization

Hopkins et al. (2022a) Freshwater Sci; (2020) Hydrol Proc 16

• How does urbanization 
alter the water balance?

• Do mitigation measures 
(stormwater control) 
reduce the impacts of 
urbanization?

https://doi.org/10.1086/719360
https://doi.org/10.1002/hyp.13593


Urbanization ↑ runoff ↑ peak discharge ↓ baseflow ↓ water quality 

Hopkins et al. (2022a) Freshwater Sci; (2020) Hydrol Proc 17

https://doi.org/10.1086/719360
https://doi.org/10.1002/hyp.13593


Drinking water

Photo credit: Minnesota Pollution Control Agency

The confluence of the St. Croix (left) and Mississippi (right) rivers. 

Minneapolis Water Treatment and Distribution 
• Processes: 21 billion gal/year of raw water from the 

Mississippi River headwaters

• Serves: > 500,000 people

• Concerns: agricultural expansion, population growth, 
urbanization, climate change

Woznicki et al. (2023) J. Am. Water Res Assoc 18

https://onlinelibrary.wiley.com/doi/pdf/10.1111/1752-1688.13109


Drinking water

LCLUC by 2050:

• Forest loss to agriculture in 
headwaters

• Agriculture loss to expansion of 
Minneapolis urban footprint 
associated with population growth

Coupled land use change and hydrological modeling

Water quality changes by 2050:

• Raw water nutrient loads increase in more 
extreme forest loss scenarios 

• Impact is greatest in early growing season

• Greater water treatment costs

19Woznicki et al. (2023) J. Am. Water Res Assoc

https://onlinelibrary.wiley.com/doi/pdf/10.1111/1752-1688.13109


Forest hydrology: bark beetle infestation

Pugh and Gordon (2013) Hydrological Processes 20

Infestation-induced tree 
death mapped using RS 
(some examples)
• Barta et al. (2022)

• Dalponte et al. (2022)

• Fernandez-Carillo et al. (2020)

Hydrological impacts:

• Transpiration ↓

• Canopy interception ↓

• Baseflow ↑

• Peak flow ↑

• Soil evaporation ↑

Phases of infestation and hydrologic changes

https://doi.org/10.1002/hyp.9312
https://doi.org/10.1002/hyp.9312
https://doi.org/10.1016/j.foreco.2021.119984
https://doi.org/10.3390/rs14133135
https://doi.org/10.3390/rs12213634


Post-wildfire hydrology: ↑ runoff ↑ erosion ↓ water quality

21Hohner et al. (2019) Acc. Chem. Res

https://doi.org/10.1021/acs.accounts.8b00670
https://doi.org/10.1021/acs.accounts.8b00670


Post-wildfire hydrology

22

Linking normalized burn ratio (NBR, MODIS MOD13Q1) to 
pre- and post-fire rainfall-runoff events

Moreno et al. (2020) J Hydrol

Pre-fire runoff event Post-fire runoff event

All parts of flow 
regime affected

https://doi.org/10.1016/j.jhydrol.2019.124244


Socio-hydrology and interdisciplinary studies

23

“Socio-hydrology can deal with a 

range of policy-relevant

questions… while hydrology alone 

cannot address these questions as 

it fails to consider how 

anthropogenic activities affect 

natural hazards, and vice versa 

(Di Baldassarre et al., 2021)”

Vanelli et al. (2022) HESS

https://doi.org/10.1029/2021av000473
https://doi.org/10.5194/hess-26-2301-2022


Socio-hydrology and interdisciplinary studies
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“Socio-hydrology can deal with a range 

of policy-relevant questions… while 

hydrology alone cannot address these 

questions as it fails to consider how 

anthropogenic activities affect 

natural hazards, and vice versa 

(Di Baldassarre et al., 2021)”

Remote sensing can (and does) play 

a direct role in socio-hydrology 

Vanelli et al. (2022) HESS

https://doi.org/10.1029/2021av000473
https://doi.org/10.5194/hess-26-2301-2022


Hydrological modeling: model specifications

• Simulation type
• Event (single-storm)
• Continuous (long-term)

• Physical representation?
• Empirical/statistical
• Conceptual
• Process or physics-based

• Spatial structure
• Lumped
• Semi-distributed
• Distributed

25Penn State Integrated Hydrological Model

http://www.pihm.psu.edu/index.html
http://www.pihm.psu.edu/index.html


Hydrological modeling: key processes

• Overland flow

• Soil water/moisture

• Capillary lift

• Evaporation and transpiration

• Groundwater recharge

• Groundwater flow

26Penn State Integrated Hydrological Model

http://www.pihm.psu.edu/index.html
http://www.pihm.psu.edu/index.html


Model spatial structure: rainfall-runoff models

27

Lumped Distributed (gridded)Semi-distributed

INCREASINGLY DETAILED REPRESENTATION OF SPATIAL PROCESSES

Sitterson et al. (2017)

https://scholarsarchive.byu.edu/cgi/viewcontent.cgi?article=3977&context=iemssconference
https://scholarsarchive.byu.edu/cgi/viewcontent.cgi?article=3977&context=iemssconference


Process spatial and temporal scales

Important

processes in 

the region of 

interest affect 

model choices 

and model 

setup

28

Spatial and temporal scales of hydrological processes in urban areas, 

Elga et al. (2015) J Hydrol)

https://doi.org/10.1016/j.jhydrol.2015.06.028


Model spatial and temporal scales 

29Bloschl and Sivapalan (1995) Hyd Proc

Soil moisture models → hillslope models → catchment models → global hydrological models

https://doi.org/10.1002/hyp.3360090305


Robust hydrological process 
representation

• Data requirements (blue)

• Objectives (white)

• Decision points (green)

• Model selection (pink)

• Improvements in model 
development (yellow)

30Sidle (2021) Geoscience Letters

https://doi.org/10.1186/s40562-021-00193-9
https://doi.org/10.1186/s40562-021-00193-9


Model parameterization: an inverse problem

31

DATA TO PARAMETERS 
representing key 
physical/conceptual 
processes

(at catchment 
outlet 

discharge gage)

(or uncertain)

Image credit: Hydrological Modelling 
and the Water Cycle (2008). 
Sooroshian et al. (eds)

https://link.springer.com/book/10.1007/978-3-540-77843-1
https://link.springer.com/book/10.1007/978-3-540-77843-1


Calibration/Uncertainty Analysis

• Model assessment: How well does the 
model capture reality?

• Assessment options using measurements:
1. River discharge at catchment outlet

• Global Runoff Data Centre (GRDC) data

2. Catchment internal processes (spatial)
• Evapotranspiration (RS)
• Depth to water table (wells or coarse country 

datasets)
• Crop yield (country datasets/ RS?)

• 1 & 2 (best option)

32

Observations vs. simulation

Woznicki et al. (2023) JAWRA (Supplemental)

https://doi.org/10.1111/1752-1688.13109


Model parameterization: an inverse problem

33

ADJUST PARAMETER VALUES to 
maximize agreement between 
simulation and observation 

Iterative 
process

(or uncertain)

Image credit: Hydrological Modelling 
and the Water Cycle (2008). 
Sooroshian et al. (eds)

https://link.springer.com/book/10.1007/978-3-540-77843-1
https://link.springer.com/book/10.1007/978-3-540-77843-1


Remote sensing datasets used in hydrology studies 
*Not a complete list!

• Precipitation (TRMM, GPM)

• Surface water extent (Landsat, MODIS, Sentinel-1, Sentinel-2, VHR)

• Land cover/land use (Landsat, MODIS, Sentinel-1, Sentinel-2, VHR)

• Soil moisture (GRACE, SMAP, Sentinel-1)

• Terrestrial water storage (GRACE, GRACE-FO)

• Evapotranspiration (MODIS, Landsat, AVHRR)

• Surface water elevation (SWOT, ICESat-2)

34

Can be used in forcing, assimilation, parameterization (initial conditions/physical 
processes), and/or model calibration/evaluation (depending on the data)



Soil and Water Assessment Tool (SWAT / SWAT+)
• Components:

• Land-based hydrological cycle

• Channel processes and routing

• Plant growth

• Land management practices

• Erosion

• Nutrient cycles and transport

• Characteristics:
• Continuous (long-term)

• Semi-distributed

• Hybrid: physical process information coupled 
with conceptual and empirical algorithms

35

https://swat.tamu.edu/software/plus/



Soil and Water Assessment Tool (SWAT / SWAT+)

• “Comprehensive tool for simulating 
streamflow and pollutant transport 
across a wide range of spatial and 
temporal scales, environmental 
conditions, land management 
practices, and land use and climate 
change scenarios” (Bieger et al. 2016)

• Components:
• Land-based hydrological cycle
• Channel processes and routing
• Plant growth
• Land management practices
• Erosion
• Nutrient cycles and transport

• Open-source code

• Can be coupled with complex 
groundwater models

36

~5900 peer-reviewed articles using SWAT as of March 2023

SWAT Publication Database

https://onlinelibrary.wiley.com/doi/full/10.1111/1752-1688.12482
https://www.card.iastate.edu/swat_articles/
https://www.card.iastate.edu/swat_articles/


SWAT+ Data Requirements

• Digital elevation model (DEM)

• Soil raster with database of key parameters
• E.g., Sand/Silt/Clay, hydraulic conductivity, bulk 

density, etc.

• Land cover / land use map

• Daily weather (tabular with coordinates)

• Other (optional, dependent on catchment):
• Reservoir volumes and operation

• Common crop rotations and land management

37



Spatial representation 
in SWAT+
• Many spatial objects in SWAT+ with variety of 

connections for flow routing:

a) Upland to floodplain to river channel (runoff)

b) Upland to aquifer (recharge)

c) Channel to reservoir (river flow)

d) Withdrawal from reservoir to upland 
(irrigation)

38https://swatplus.gitbook.io/docs/user/editor/inputs/connections



Overview of modeling process in SWAT+

1. Catchment/watershed delineation (digital elevation model)

2. Landscape characterization = Landscape units (LSUs)

3. Hydrologic response units (HRUs) definition

4. Weather inputs (daily precipitation, temperature, rel. humidity, wind 
speed, solar radiation)

5. Other (optional decision tables): 
1. Parameterize agricultural/forestry management operations
2. Initialize reservoir operations

39



Watershed/catchment delineation (drainage based)

• Requires digital elevation model 
(DEM) and (optional) stream 
network shapefile

• Calculates flow direction and flow 
accumulation based on a defined 
outlet/pour point

• Defines catchment boundary

• Defines subcatchments based on 
stream network

40

OUTLET

Subbasin
Subbasin

Subbasin



Watershed/catchment delineation (grid-based)

• Requires digital elevation model 
(DEM) and (optional) stream 
network shapefile

• Calculates flow direction and flow 
accumulation based on a defined 
outlet

• Defines catchment boundary

• Defines grid cells and attaches 
them to stream network

41

OUTLET



Calculate landscape units (LSUs)

• Partition catchment into 
floodplain and upland units

• Multiple methods
• Buffer (e.g. 25 m)

• DEM-based using low points 
on the landscape

42

Floodplain unit



Hydrologic response unit (HRU) definition

• Each HRU has uniform land 
use/soil/slope/land management

• Lumped aspatial units with 
subbasin or grid cell

• Computationally efficient

• User defined level of aggregation

• Model is param

43

Credit: Amin Zettam



Ingest daily weather data

• Precipitation

• Minimum and maximum temperature

• Relative humidity*

• Wind speed*

• Solar radiation*

44

E-OBS daily gridded meteorological data for 
Europe from 1950 to present derived from 
in-situ observations

*Not required, SWAT+ weather generator 
(WGEN) can create based on long-term global 
weather generator database

https://cds.climate.copernicus.eu/cdsapp#!/dataset/insitu-gridded-observations-europe?tab=overview
https://cds.climate.copernicus.eu/cdsapp#!/dataset/insitu-gridded-observations-europe?tab=overview
https://cds.climate.copernicus.eu/cdsapp#!/dataset/insitu-gridded-observations-europe?tab=overview


Other model components

• Agricultural decisions
• Irrigation

• Planting and harvesting

• Rotations

• Tillage

• Reservoir operations

• Water withdrawals

• Point source discharges

45

Irrigation based on soil water thresholds

Arnold et al. (2018) Water

https://doi.org/10.3390/w10060713


Upcoming NASA Applied Remote Sensing 
Training Program (ARSET) session

• Pre-fire land cover 
mapping

• Watershed delineation

• Post-fire burn severity

• Pre- and post-fire 
hydrology/water 
quality modeling with 
SWAT

46

https://appliedsciences.nasa.gov/join-mission/training/english/arset-assessing-impacts-fires-watershed-health
https://appliedsciences.nasa.gov/join-mission/training/english/arset-assessing-impacts-fires-watershed-health


Acknowledgements

• Jillian Greene (GVSU graduate student)

• Jamshid Jalali (GVSU graduate student)

• Premek Stych

• Garik Gutman

47
Grant #80NSSC22K0467



SWAT Walkthrough – Setup

• QGIS > Plugins > Install Plugins > 
Install SWAT+

• Click SWAT+ tool, , in the top-right 
of the QGIS toolbar

• Create New Project > select directory 
> svratka_model

• Delineate Watershed

48



SWAT Walkthrough – Delineate Watershed

• Select DEM > 
Model_Inputs/DEM/svratka_dem.tif

• Uncheck Burn in existing stream network

• Create streams

• Leave inlets/outlets unchecked

• Check Make grid, enter 20, click Create 
watershed

• Create landscape > Create > DEM 
inversion with 9763 cells & 0.10 slope > 
Create > Done

• Click OK

49



SWAT Walkthrough – Create HRUs

Landuse and soil

• Select landuse map > 
Landcover/svratka_landcover.tif

• Select soil map > HWSD/svratka_soils.tif

• Leave landuse and soil database as default

• Soil data > usersoil

• Tables > Landuse lookup > 
Landcover/landuse_lookups.csv

• Tables > Soil lookup > HWSD/svratka_soils.csv

• Tables > Usersoil > 
HWSD/svratka_usersoil_main.csv, then 
svratka_usersoil_layers.csv

50



SWAT Walkthrough – Create HRUs (cont.)

• Set slope bands at 5 and 10%

• Reservoir threshold and elevation bands will be 
left as the default

• Enter invflood_10.tif in the floodplain map 
dropdown

• Select Read from maps and Read

HRUs

• In HRUs tab, select Filter by landuse, soil, slope

• Landuse = 10% > Go

• Soil = 10% > Go

• Slope = 10% > Create HRUs

51



SWAT Walkthrough – Run SWAT+

• Click Edit Inputs and Run SWAT+, Start

• Click Edit SWAT+ Inputs,

• Weather Generator > Import Data > Start

• Weather Stations > Import Data > 
Weather > Start

• Click Run SWAT+,

• Simulation period = 2018-2022

• Output to print > warm-up period = 2 
years

• Select only the outputs displayed to the 
right. Save Settings & Run Selected

52

Outputs to Select



SWAT Walkthrough – Visualize: Map

• Click Visualize

• Choose SWAT+ output table > lsunit_wb_aa

• Static maps > Choose variables > surq_gen > Add > 
Create

53



SWAT Walkthrough – Visualize: Time Series

• Click Visualize

• Choose SWAT+ output table > 
channel_sd_mon

• Plots > Choose observed data file > 
GRDC_Stations/6142260_observedFlow.csv

• Plot type > Graph/bar chart

• Unit > 270

• Variable > flo_out > Add plot

• Add observed

• Plot

• Create CSV filename, svratka_flow_plot > 
Save

54



SWAT Walkthrough – Visualize: Time Series

55



SWAT Walkthrough – Landcover Change Example

• Create a secondary SWAT+ project using the 
same parameters except the landuse map

• In Create HRUs > Select landuse map > 
Landcover/landcover_change.tif

• In Visualize Results > Choose SWAT+ output 
table > lsunit_ls_aa

• Choose variables > sedyld > Add > Create

• Compare these sedyld results to the original 
project's sedyld results

• Note changes in sediment yield in the 
Northeast corner where "reforestation" 
occurred

56
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